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1 硬件架构 

1.1 系统架构 

Gowin_EMPU_M3，包括三级结构，如图 1-1 所示。 

图 1-1 系统架构 

 
 

第一级，MCU Core System，包括 ARM Cortex-M3 Processor Core、

Instruction Memory 和 Data Memory，以及 Peripheral Interface。 

第二级，AHB Bus System，包括 GPIO、Ethernet、DDR3 Memory、

SPI-Flash 和 AHB2 Extension。 

第三级，APB Bus System，包括 UART0、UART1、Timer0、Timer1、

WatchDog、RTC、I2C Master、SPI Master、SD-Card 和 APB2 Extension。 

1.2 系统特征 

Gowin_EMPU_M3，包括三级子系统结构： 
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 MCU Core System 子系统 

 AHB Bus System 子系统 

 APB Bus System 子系统 

1.2.1 MCU Core System 子系统 

处理器内核 

 ARM architecture v7-M Thumb2 指令集架构，支持 16-bit 和 32-bit 指令

集 

 支持 MPU（Memory Protection Unit） 

 支持 WIC（Wakeup interrupt Controller） 

 支持 Bit-banding 

 支持 sleep mode 电源管理，降低系统功耗 

 中断异常处理和正常线程模式 

 支持数据和指令大小端格式 

 系统时钟频率建议 40MHz 以下 

NVIC（Nested Vector Interrupt Controller） 

 提供 16 个用户中断处理信号，用于用户设备扩展中断处理功能 

 支持 256 级中断优先级等级 

 进入中断处理时自动保存处理器状态，中断处理结束时自动恢复状态 

调试系统 

支持调试等级可配置： 

 No debug 

 Minimum debug 

 Full debug minus DWT（Data Watchpoint and Trace） 

 Full debug plus DWT 

支持调试接口可配置： 

 Serial Wire 

 JTAG and Serial Wire 

支持 Trace 等级可配置： 

 No trace 

 Standard trace. ITM（Instrumentation Trace Macrocell and DWT （Data 

Watchpoint Trace）, No ETM（Embedded Trace Macrocell） 

 Full trace. ITM, DWT and ETM 

 High trace. ITM, DWT, ETM and HTM（AHB Trace Macrocell） 

Memory 

 Instruction Memory：指令存储器，Size 可以配置为 16KB、32KB、64KB

或 128KB，支持 bootload 初始值文件加载； 
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 Data Memory：数据存储器，Size 可以配置为 16KB、32KB、64KB 或

128KB。 

1.2.2 AHB Bus System 子系统 

AHB 总线接口外部设备： 

 GPIO 

 Ethernet 

 DDR3 Memory 

 SPI-Flash 

 AHB2 Extension 

1.2.3 APB Bus System 子系统 

APB 总线接口外部设备： 

 UART0/1 

 Timer0/1 

 WatchDog 

 RTC 

 I2C Master 

 SPI Master 

 SD-Card 

 APB2 Extension 

1.3 系统端口 

Gowin_EMPU_M3 系统端口定义，如表 1-1 所示。 

表 1-1 系统端口定义 

名称 I/O 位宽 描述 所属模块 

HCLK in 1 系统时钟 – 

hwRstn in 1 系统复位 – 

LOCKUP out 1 内核lockup状态 – 

HALTED out 1 内核halt debug状态 – 

JTAG_3 inout 1 调试接口TRSTN 

DAP 

JTAG_4 inout 1 调试接口NC 

JTAG_5 inout 1 调试接口TDI 

JTAG_6 inout 1 调试接口NC 

JTAG_7 inout 1 调试接口TMS/SWDIO 

JTAG_8 inout 1 调试接口HOLDN 

JTAG_9 inout 1 调试接口TCK/SWCLK 

JTAG_10 inout 1 调试接口SIO1 

JTAG_11 inout 1 调试接口NC 

JTAG_12 inout 1 调试接口SCLK 
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名称 I/O 位宽 描述 所属模块 

JTAG_13 inout 1 调试接口TDO/SWO 

JTAG_14 inout 1 调试接口SIO0 

JTAG_15 inout 1 调试接口SRSTN 

JTAG_16 inout 1 调试接口CS 

JTAG_17 inout 1 调试接口NC 

JTAG_18 inout 1 调试接口WPN 

IRQ in [15:0] 用户中断处理信号 NVIC 

GPIO inout [15:0] 通用输入输出端口 GPIO 

UART0RXD in 1 UART0接收端口 
UART0 

UART0TXD out 1 UART0发送端口 

UART1RXD int 1 UART1接收端口 
UART1 

UART1TXD out 1 UART1发送端口 

TIMER0EXTIN in 1 Timer0外部中断 Timer0 

TIMER1EXTIN in 1 Timer1外部中断 Timer1 

RTCSRCCLK in 1 RTC时钟源32.768KHz RTC 

SCL inout 1 串行时钟 
I2C Master 

SDA inout 1 串行数据 

MOSI out 1 主设备输出/从设备输入 

SPI Master 
MISO in 1 主设备输入/从设备输出 

SCLK out 1 时钟信号 

NSS out 1 从设备选择信号 

SD_SPICLK in 1 SPI时钟信号 

SD-Card 

SD_CLK out 1 SD时钟信号 

SD_CS out 1 片选信号 

SD_DATAIN in 1 数据输入 

SD_DATAOUT out 1 数据输出 

SD_CARD_INIT out 1 初始化”0” 

SD_CHECKIN in 1 输入检查 

SD_CHECKOUT out 1 输出检查 

RGMII_TXC out 1 RGMII发送时钟 

Ethernet RGMII Interface 

RGMII_TX_CTL out 1 RGMII发送控制 

RGMII_TXD out [3:0] RGMII发送数据 

RGMII_RXC in 1 RGMII接收时钟 

RGMII_RX_CTL in 10 RGMII接收控制 

RGMII_RXD in [3:0] RGMII接收数据 

GTX_CLK in 1 
RGMII 125MHz时钟输

入 

GMII_RX_CLK in 1 GMII接收时钟 
Ethernet GMII Interface 

GMII_RX_DV in 1 GMII接收使能 
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名称 I/O 位宽 描述 所属模块 

GMII_RXD in [7:0] GMII接收数据 

GMII_RX_ER in 1 GMII接收错误 

GTX_CLK in 1 GMII 125MHz时钟输入 

GMII_GTX_CLK out 1 GMII发送时钟 

GMII_TXD out [7:0] GMII发送数据 

GMII_TX_EN out 1 GMII发送使能 

GMII_TX_ER out 1 GMII发送错误 

MII_RX_CLK in 1 MII接收时钟 

Ethernet MII Interface 

MII_RXD in [3:0] MII接收数据 

MII_RX_DV in 1 MII接收使能 

MII_RX_ER in 1 MII接收错误 

MII_TX_CLK in 1 MII发送时钟 

MII_TXD out [3:0] MII发送数据 

MII_TX_EN out 1 MII发送使能 

MII_TX_ER out 1 MII发送错误 

MII_COL in 1 MII冲突信号 

MII_CRS in 1 MII载波信号 

MDC out 1 管理通道时钟 
Ethernet 

MDIO inout 1 管理通道数据 

DDR_CLK_I in 1 50MHz时钟输入 

DDR3 

DDR_INIT_COMPLETE_O out 1 初始化完成信号 

DDR_ADDR_O out [15:0] Row地址、Column地址 

DDR_BA_O out [2:0] Bank地址 

DDR_CS_N_O out 1 片选信号 

DDR_RAS_N_O out 1 Row地址选通信号 

DDR_CAS_N_O out 1 Column地址选通信号 

DDR_WE_N_O out 1 Row写使能 

DDR_CLK_O out 1 
提供给DDR3 SDRAM

的时钟信号 

DDR_CLK_N_O out 1 
与DDR_CLK_O组成差

分信号 

DDR_CKE_O out 1 
DDR3 SDRAM时钟使

能信号 

DDR_ODT_O out 1 内存信号端接电阻控制 

DDR_RESET_N_O out 1 
DDR3 SDRAM复位信

号 

DDR_DQM_O out [1:0] 
DDR3 SDRAM数据屏

蔽信号 

DDR_DQ_IO inout [15:0] DDR3 SDRAM数据 

DDR_DQS_IO inout [1:0] 
DDR3 SDRAM数据选

通信号 
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名称 I/O 位宽 描述 所属模块 

DDR_DQS_N_IO inout [1:0] 
与DDR_DQS_IO组成差

分信号 

FLASH_SPI_HOLDN inout 1 NC 

SPI-Flash 

FLASH_SPI_CSN inout 1 从设备选择信号 

FLASH_SPI_MISO inout 1 主设备输入/从设备输出 

FLASH_SPI_MOSI inout 1 主设备输出/从设备输入 

FLASH_SPI_WPN inout 1 NC 

FLASH_SPI_CLK inout 1 时钟信号 

APB2PSTRB out [3:0] APB2 PSTRB 

APB2 Extension 

APB2PPROT out [2:0] APB2 PPROT 

APB2PSEL out 1 APB2 PSEL 

APB2PENABLE out 1 APB2 PENABLE 

APB2PADDR out [31:0] APB2 PADDR 

APB2PWRITE out 1 APB2 PWRITE 

APB2PWDATA out [31:0] APB2 PWDATA 

APB2PRDATA in [31:0] APB2 PRDATA 

APB2PREADY in 1 APB2 PREADY 

APB2PSLVERR in 1 APB2 PSLVERR 

APB2PCLK out 1 APB2 PCLK 

APB2PRESET out 1 APB2 RESET 

AHB2HSEL out 1 AHB2 HSEL 

AHB2 Extension 

AHB2HADDR out [31:0] AHB2 HADDR 

AHB2HTRANS out [1:0] AHB2 HTRANS 

AHB2HWRITE out 1 AHB2 HWRITE 

AHB2HSIZE out [2:0] AHB2 HSIZE 

AHB2HBURST out [2:0] AHB2 HBURST 

AHB2HPROT out [3:0] AHB2 HPROT 

AHB2HWDATA out [31:0] AHB2 HWDATA 

AHB2HMASTLOCK out 1 AHB2 HMASTLOCK 

AHB2HREADYMUX out 1 AHB2 HREADYMUX 

AHB2HRDATA in [31:0] AHB2 HRDATA 

AHB2HREADYOUT in 1 AHB2 HREDAYOUT 

AHB2HRESP in [1:0] AHB2 HRESP 

AHB2HMASTER out [3:0] AHB2 MASTER 

AHB2HCLK out 1 AHB2 HCLK 

AHB2HRESET out 1 AHB2 RESET 

1.4 系统资源统计 

Gowin_EMPU_M3 系统资源统计，如表 1-2 所示。 
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表 1-2 系统资源统计 

Resources 
Configuration 

LUTs Registers BSRAMs 
DSP 
Macros 

MCU Core System Minimum and No 
Peripherals 

17138 2245 16 2 

MCU Core System Default and No 
Peripherals 

22732 4634 64 2 

MCU Core System Maximum and No 
Peripherals 

25290 5571 128 2 

MCU Core System and All Peripherals 
Maximum 

37345 12981 111 2 
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2 硬件设计流程 

2.1 硬件环境 

DK-START-GW2A55 V1.3：GW2A-LV55PG484C8/I7 

2.2 软件环境 

Gowin_V1.9.5.01 Beta 及以上版本。 

2.3 IP Core Generator 

Gowin 云源软件的 IP Core Generator，用于配置和产生

Gowin_EMPU_M3 硬件设计。 

IPCore Generator 软件使用方法请参考 SUG284，Gowin IP Core 

Generator 用户指南。 

2.4 Programmer 

Gowin 下载软件 Programmer，用于码流文件下载。 

Programmer 软件使用方法请参考 SUG502，Gowin Programmer 用户

指南。 

2.5 设计流程 

Gowin_EMPU_M3 硬件设计流程： 

1. IP Core Generator 中配置 MCU Core System、AHB Bus System 和 APB 

Bus System，产生 Gowin_EMPU_M3 硬件设计，导入当前工程； 

2. 实例化 Gowin_EMPU_M3 Top Module，导入用户应用设计，连接用户

应用设计与 Gowin_EMPU_M3 Top Module； 

3. 物理约束和时序约束； 

4. Synplify Pro 或 GowinSynthesis 综合； 

5. Place & Route 布局布线，产生码流文件； 

6. Programmer 下载码流文件到 GW2A-55/GW2A-55C。 

http://cdn.gowinsemi.com.cn/SUG284.pdf
http://cdn.gowinsemi.com.cn/SUG502.pdf
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3 工程模板 

3.1 创建工程 

3.1.1 创建工程 

双击打开 Gowin 云源软件，选择菜单栏“File > New… > FPGA Design 

Project”，创建 FPGA Design Project，如图 3-1 所示。 

图 3-1 创建 FPGA Design 工程 

 
 

3.1.2 设定工程名称和路径 

输入工程名称，选择工程路径，如图 3-2 所示。 
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图 3-2 设定工程名称和路径 

 

3.1.3 选择器件 

选择“Series”、“Device”、“Package”、“Speed”和“Part Number”，

如图 3-3 所示。 

以软件开发工具包参考设计为例，如下所示： 

 Series：GW2A 

 Device：GW2A-55 

 Package：PBGA484 

 Speed：C8/I7 

 Part Number：GW2A-LV55PG484C8/I7 
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图 3-3 选择器件 

 

3.1.4 完成工程创建 

如图 3-4 所示，完成工程创建。 

图 3-4 完成工程创建 

 

3.2 硬件设计 

使用 IP Core Generator 产生 Gowin_EMPU_M3 硬件设计。 

选择菜单栏“Tools > IP Core Generator”或工具栏 IP Core Generator
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“ ”，打开 IP Core Generator。 

选择“Soft IP Core > Microprocessor System > Soft-Core-MCU > 

Gowin_EMPU_M3 1.0”，如图 3-5 所示。 

图 3-5 选择 Gowin_EMPU_M3 

 
 

打开 Gowin_EMPU_M3，系统结构如图 3-6 所示。 

包括“MCU Core System”、“AHB Bus System”和“APB Bus System”

三级子系统配置。 
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图 3-6 系统架构图 

 

3.2.1 MCU Core System 配置 

MCU Core System 子系统配置选项，如表 3-1 所示。 

表 3-1 MCU Core System 配置选项 

配置选项 描述 

Enable User Interrupts 
开放16个用户中断处理信号，用于用户设备中断处理功能； 

默认关闭。 

Enable MPU 
使能Memory Protection Unit； 

默认使能。 

Enable WIC 
使能Wakeup Interrupt Controller； 

默认使能。 

Enable Bit-banding 
使能Bit-banding； 

默认使能。 

IRQ Priority Level Width 
配置中断优先级位宽，取值范围3~8； 

默认取值为3。 

WIC Lines 
配置Wakeup Interrupt Controller Lines，取值范围3~243； 

默认取值为3。 

Debug Level 
配置调试系统等级： 

No debug 
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配置选项 描述 

Minimum debug 
Full debug minus DWT 
Full debug plus DWT 

默认Full debug plus DWT 

Trace Level 

配置跟踪系统等级： 

No trace 
Standard trace. ITM and DWT, No ETM 
Full trace. ITM, DWT and ETM 
High trace. ITM, DWT, ETM and HTM 

默认Standard trace. ITM and DWT, No ETM 

Debug Interface 

配置调试接口： 

Serial wire 
JTAG and serial wire 

默认JTAG and serial wire 

Instruction Memory Size 
取值16KB、32KB、64KB或128KB； 

默认64KB。 

Initialization File Path bootload初始值文件路径，用于片外SPI-Flash下载启动。 

Data Memory Size 
取值16KB、32KB、64KB或128KB； 

默认64KB。 

 

双击 MCU Core Systm，打开 MCU Core System 配置选项，包括

Configuration、Debug、Instruction Memory 和 Data Memory 配置选项。 

Configuration 

选择 Configuration 配置选项，如图 3-7 所示，可以配置 User Interrupts、

MPU、WIC、Bit-banding、IRQ Priority Level Width 和 WIC Lines。 
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图 3-7 Configuratio 

 
 

 User Interrupts 配置 

- Gowin_EMPU_M3 提供 16 个用户中断处理信号，用于用户设备扩

展中断处理功能。 

- 如果选择 Enable User Interrupts，则 Gowin_EMPU_M3 支持用户中

断处理，否则不支持。 

- 默认关闭。 

 MPU 配置 

- 如果选择 Enable MPU，则 Gowin_EMPU_M3 支持 MPU，否则不

支持。 

- 默认选择。 

 WIC 配置 

- 如果选择 Enable WIC，则 Gowin_EMPU_M3 支持 WIC，否则不支

持。 

- 默认选择。 

 Bit-banding 配置 

- 如果选择 Enable Bit-banding，则 Gowin_EMPU_M3 支持

Bit-banding，否则不支持。 

- 默认选择。 
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 IRQ Priority Level Width 配置 

- 配置中断优先级位宽，取值范围 3~8，可以支持 8~256 级中断优先

级等级。 

- 默认为 3。 

 WIC Lines 配置 

- 配置 WIC Lines，取值范围 3~243。 

- 默认为 3。 

Debug 

选择Debug配置选项，如图3-8所示，可以配置Debug Level、TraceLevel

和 Debug Interface。 

图 3-8 Debug 

 
 

 Debug Level 配置 

配置调试系统功能等级，包括： 

- No debug 

- Minumum debug 

- Full debug minus DWT 

- Full debug plus DWT 

注！ 
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默认 Full debug plus DWT。 

 Trace Level 配置 

配置跟踪系统功能等级，包括： 

- No trace 

- Standard trace. ITM and DWT, No ETM 

- Full trace. ITM, DWT and ETM 

- High trace. ITM, DWT ETM and HTM 

注！ 

默认 Standard trace. ITM and DWT, No ETM。 

 Debug Interface 配置 

配置调试接口类型，包括： 

- Serial wire 

- JTAG and serial wire 

注！ 

默认 JTAG and serial wire。 

Instruction Memory 

选择 Instruction Memory 配置选项，如图 3-9 所示，可以配置 Instruction 

Memory Size 和 Initialization File Path。 

图 3-9 Instruction Memory 
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 Instruction Memory Size 配置 

配置 Instruction Memory Size，可以配置为 16KB、32KB、64KB 或 128KB。

默认为 64KB。 

 Initialization File Path 配置 

配置 bootload 初始化文件路径，用于片外 SPI-Flash 下载启动方式。根

据不同的 Instruction Memory Size，加载不同的 bootload 文件路径，如

下所示。 

- 如果 Instruction Memory Size配置为16KB，则 Initialization File Path

加载软件开发工具包的 INSMEM_Size_16KB bootload 初始化文件 

- 如果 Instruction Memory Size配置为32KB，则 Initialization File Path

加载软件开发工具包的 INSMEM_Size_32KB bootload 初始化文件 

- 如果 Instruction Memory Size配置为64KB，则 Initialization File Path

加载软件开发工具包的 INSMEM_Size_64KB bootload 初始化文件 

- 如果 Instruction Memory Size 配置为 128KB，则 Initialization File 

Path 加载软件开发工具包的 INSMEM_Size_128KB bootload 初始

化文件 

注！ 

Instruction Memory Initialization Path 导入的路径，不能有以数字命名的文件夹路径。 

Data Memory 

选择 Data Memory 配置选项，如图 3-10 所示，可以配置 Data Memory 

Size。 
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图 3-10 Data Memory 

 
 

配置 Data Memory Size，可以配置为 16KB、32KB、64KB 或 128KB。

默认为 64KB。 

3.2.2 AHB Bus System 配置 

AHB Bus System 子系统配置选项，如表 3-2 所示。 

表 3-2 AHB Bus System 配置选项 

配置选项 描述 

Enable GPIO 
使能 GPIO 

默认关闭 

Enable Ethernet 
使能 Ethernet 

默认关闭 

Interface 
Ethernet 选择 Interface (RGMII/GMII/MII) 

默认为 RGMII 

RGMII Input Delay 
RGMII input delay 

默认值为 100 

MIIM Clock Divider 
MIIM clock divider 

默认值为 20 

Enable DDR3 
使能 DDR3 Memory 

默认关闭 

Enable SPI-Flash 
使能 SPI-Flash 下载功能和 Memory 读、写、擦除功能 

默认使能 

Enable AHB2 Extension 使能 AHB2 扩展接口 
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配置选项 描述 

默认关闭 

 

GPIO 配置 

双击打开 GPIO，可以选择配置 GPIO，如图 3-11 所示。 

如果选择 Enable GPIO，则 Gowin_EMPU_M3 支持 GPIO，默认关闭。 

图 3-11 GPIO 配置 

 
 

Ethernet 配置 

双击打开 Ethernet，可以选择配置 Ethernet，如图 3-12 所示。 

 如果选择 Enable Ethernet，则 Gowin_EMPU_M3 支持 Ethernet，默认

关闭。 

 如果已经选择 Enable Ethernet，则可以配置 Interface、RGMII Input 

Delay、MIIM Clock Divider。 

- 选择 Interface，可以选择配置 RGMII、GMII、MII 或 GMII/MII，默

认为 RGMII。 

- 如果 Interface 配置为 RGMII，则可以选择配置 RGMII Input Delay，

默认值为 100。 

- 选择 MIIM Clock Divider，可以配置 MIIM Clock Divider，默认值为

20。 

- 如果 Interface 选择 RGMII 或 GMII，则端口 GTX_CLK 必须接入

125MHz 时钟输入。 
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图 3-12 Ethernet 配置 

 
 

DDR3 配置 

双击打开 DDR3，可以选择配置 DDR3，如图 3-13 所示。 

如果选择 Enable DDR3，则 Gowin_EMPU_M3 支持 DDR3 Memory，默

认关闭。 

DDR3 内部时钟频率 150MHz。 

DDR3 端口 DDR_CLK_I 必须接入 50MHz 时钟输入。 
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图 3-13 DDR3 配置 

 
 

SPI-Flash 配置 

SPI-Flash 支持下载功能，和 Memory 读、写、擦除功能。 

双击打开 SPI-Flash，可以选择配置 SPI-Flash，如图 3-14 所示。 

如果选择 Enable SPI-Flash，则 Gowin_EMPU_M3 支持 SPI-Flash，默认

使能。 
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图 3-14 SPI-Flash 配置 

 
 

AHB2 Extension 配置 

双击打开 AHB2 Extension，可以选择配置 AHB2 Extension，如图 3-15 所

示。 

如果选择 Enable AHB2 Extension，则 Gowin_EMPU_M3 支持 AHB2 

Extension，用户可以在此接口自行连接扩展的 AHB 外部设备，默认关闭。 
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图 3-15 AHB2 Extension 配置 

 

3.2.3 APB Bus System 配置 

APB Bus System 子系统配置选项，如表 3-3 所示。 

表 3-3 APB Bus System 配置选项 

配置选项 描述 

Enable UART0 
使能串口 0 

默认关闭 

Enable UART1 
使能串口 1 

默认关闭 

Enable Timer0 
使能定时器 0 

默认关闭 

Enable Timer1 
使能定时器 1 

默认关闭 

Enable WatchDog 
使能看门狗 

默认关闭 

Enable RTC 
使能 RTC 

默认关闭 

Enable I2C Master 
使能 I2C Master 

默认关闭 

Enable SPI Master 
使能 SPI Master 

默认关闭 

Enable SD-Card 
使能 SD-Card 

默认关闭 

Enable APB2 Extension 
使能 APB2 扩展接口 

默认关闭 
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UART 配置 

双击打开 UART0 或 UART1，可以选择配置 UART0 或 UART1，如图 3-16

所示。 

 如果选择 Enable UART0，则 Gowin_EMPU_M3 支持 UART0，默认关

闭。 

 如果选择 Enable UART1，则 Gowin_EMPU_M3 支持 UART1，默认关

闭。 

图 3-16 UART 配置 

 
 

Timer 配置 

双击打开 Timer0 或 Timer1，可以选择配置 Timer0 或 Timer1，如图 3-17

所示； 

 如果选择Enable Timer0，则Gowin_EMPU_M3支持Timer0，默认关闭。 

 如果选择Enable Timer1，则Gowin_EMPU_M3支持Timer1，默认关闭。 
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图 3-17 Timer 配置 

 
 

WatchDog 配置 

双击打开 WatchDog，可以选择配置 WatchDog，如图 3-18 所示。 

如果选择 Enable WatchDog，则 Gowin_EMPU_M3 支持 WatchDog，默

认关闭。 

图 3-18 WatchDog 配置 
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RTC 配置 

双击打开 RTC，可以选择配置 RTC，如图 3-19 所示。 

如果选择 Enable RTC，则 Gowin_EMPU_M3 支持 RTC，默认关闭。 

图 3-19 RTC 配置 

 

 

I2C Master 配置 

双击打开 I2C Master，可以选择配置 I2C Master，如图 3-20 所示。 

如果选择 Enable I2C Master，则 Gowin_EMPU_M3 支持 I2C Master，默

认关闭。 
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图 3-20 I2C Master 配置 

 
 

SPI Master 配置 

双击打开 SPI Master，可以选择配置 SPI Master，如图 3-21 所示。 

如果选择 Enable SPI Master，则 Gowin_EMPU_M3 支持 SPI Master，默

认关闭。 

图 3-21 SPI Master 配置 
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SD-Card 配置 

双击打开 SD-Card，可以选择配置 SD-Card，如图 3-22 所示。 

如果选择 Enable SD-Card，则 Gowin_EMPU_M3 支持 SD-Card，默认关

闭。 

SD-Card 端口 SD_SPICLK，必须接入 30MHz 的时钟输入。 

图 3-22 SD-Card 配置 

 
 

APB2 Extension 配置 

双击打开 APB2 Extension，可以选择配置 APB2 Extension，如图 3-23 所

示。 

如果选择 Enable APB2 Extension，则 Gowin_EMPU_M3 支持 APB2 

Extension，用户可以在此接口自行连接扩展的 APB 外部设备，默认关闭。 
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图 3-23 APB2 Extension 配置 

 
 

综合工具配置 

完成 Gowin_EMPU_M3 功能配置后，选择产生 Gowin_EMPU_M3 的综

合工具 Synplify Pro 或 GowinSynthesis，如图 3-24 所示。 



3 工程模板 3.3 用户设计 

 

IPUG923-1.0 31(36) 

 

图 3-24 综合工具配置 

 

3.3 用户设计 

 完成 Gowin_EMPU_M3 配置后，产生 Gowin_EMPU_M3 硬件设计 

 实例化 Gowin_EMPU_M3 Top Module 

 导入用户应用设计，连接 Gowin_EMPU_M3 Top Module 与用户应用设

计，形成完整的 RTL 设计 

3.4 约束 

完成用户 RTL 设计后，根据使用的开发板和需要输入输出的 IO，产生

物理约束文件。 

根据时序要求，产生时序约束文件。 

物理约束的产生方法请参考 SUG101，Gowin 设计约束指南。 

http://cdn.gowinsemi.com.cn/SUG101.pdf
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3.5 配置 

3.5.1 顶层模块配置 

综合配置选项，如图 3-25 所示。 

 选择综合工具 Synplify Pro 或 GowinSynthesis； 

 根据设计中的实际顶层模块名称配置 Top Module/Entity； 

 根据设计中的实际文件路径配置 Include Path。 

图 3-25 顶层模块配置 

 

3.5.2 Dual-Purpose Pin 配置 

Gowin_EMPU_M3 使用片外 SPI-Flash 下载启动方式，复用 SSPI 和

MSPI 端口为通用端口，如图 3-26 所示。 
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图 3-26 Dual-Purpose Pin 配置 

 

3.6 综合 

运行 Gowin 云源软件的综合工具 Synplify Pro 或 GowinSynthesis，完

成 RTL 设计的综合，如图 3-27 所示。 

图 3-27 综合 

 
 

综合工具的使用方法请参考 SUG100，Gowin 云源软件用户指南。 

3.7 布局布线 

运行 Gowin 云源软件的布局布线工具 Place & Route，完成布局布线，

产生码流文件，如图 3-28 所示。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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图 3-28 Place & Route 

 
 

布局布线工具使用方法请参考 SUG100，Gowin 云源软件用户指南。 

3.8 下载 

运行 Gowin 云源软件的下载软件 Programmer，完成码流文件的下载。 

单击 Programmer 菜单栏“Edit > Configure Device”或工具栏 Configure 

Device“ ”，打开 Device configuration。 

 Access Mode 下拉列表，选择“External Flash Mode”选项； 

 Operation 下拉列表，选择“exFlash Erase, Program”选项； 

 Programming Options > File name 选项，导入需要下载的码流文件； 

 External Flash Options > Device 选项，根据开发板板载 Flash 芯片类型

选择（如高云开发板板载 Winbond W25Q64BV）； 

 External Flash Options > Start Address 选项，配置为“0x000000”； 

 单击“Save”，如图 3-29 所示。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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图 3-29 下载 

 
 

完成 Device configuration 后，单击 Programmer 工具栏

Program/Configure“ ”，完成码流下载。 

下载工具 Programmer 使用方法请参考 SUG502, Gowin Programmer

用户指南。 

http://cdn.gowinsemi.com.cn/SUG502.pdf
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4 参考设计 

Gowin_EMPU_M3 提供硬件参考设计： 

Gowin_EMPU_M3\ref_design\FPGA_RefDesign



 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 
 


	免责声明
	版本信息
	目录
	图目录
	表目录
	1 硬件架构
	1.1 系统架构
	1.2 系统特征
	1.2.1 MCU Core System子系统
	处理器内核
	NVIC（Nested Vector Interrupt Controller）
	调试系统
	Memory

	1.2.2 AHB Bus System子系统
	1.2.3 APB Bus System子系统

	1.3 系统端口
	1.4 系统资源统计

	2 硬件设计流程
	2.1 硬件环境
	2.2 软件环境
	2.3 IP Core Generator
	2.4 Programmer
	2.5 设计流程

	3 工程模板
	3.1 创建工程
	3.1.1 创建工程
	3.1.2 设定工程名称和路径
	3.1.3 选择器件
	3.1.4 完成工程创建

	3.2 硬件设计
	3.2.1 MCU Core System配置
	Configuration
	Debug
	Instruction Memory
	Data Memory

	3.2.2 AHB Bus System配置
	GPIO配置
	Ethernet配置
	DDR3配置
	SPI-Flash配置
	AHB2 Extension配置

	3.2.3 APB Bus System配置
	UART配置
	Timer配置
	WatchDog配置
	RTC配置
	I2C Master配置
	SPI Master配置
	SD-Card配置
	APB2 Extension配置
	综合工具配置


	3.3 用户设计
	3.4 约束
	3.5 配置
	3.5.1 顶层模块配置
	3.5.2 Dual-Purpose Pin配置

	3.6 综合
	3.7 布局布线
	3.8 下载

	4 参考设计

